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Maxwell for Cinema 4D 
 
The Maxwell for Cinema 4D plugin has been designed to make using Maxwell with C4D as seamless and efficient a process as possible. To this end, 
the new plugin adds fully-integrated Maxwell Materials, along with a native-to-C4D Material Editor which is built to work in a way which is very 
similar to Maxwell’s own MXED MXM editor. 
 
Supported Platforms 
 
The download package contains binary plugin files for PCs running 32- or 64-bit versions of the Windows operating system, as well as Apple 
machines running OSX 10.5 or greater on Intel processors. Three separate downloads are available, one for Cinema 4D R9.6-R11, one for Cinema 
4D R11.5, and one for Cinema 4D R12-R13. 
 
Installation 
 
Installation is similar to that of other C4D plugins and consists of un-zipping the downloaded package and placing the unzipped folder into the 
/plugins sub-directory of your C4D program directory. For more detail, please see the readme.txt file in the unzipped plugin folder. 
 
What is covered in this plugin manual? 
 
This manual includes all the information you need to know to use the Maxwell for Cinema 4D plugin. It goes into the details of some general 
Maxwell concepts, but it is not intended to replace the regular Maxwell Render manual, which may be found in your Maxwell installation directory. 
If any non-plugin-related parameters are not explained sufficiently here, please consult the regular Maxwell Render manual for further direction.  
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What do I need to know to use the plugin? 
 
The new Maxwell for Cinema 4D plugin has been designed to work in as simple a manner as possible. Wherever appropriate, unnecessary items 
have been optimized away, leaving what is intended to be a very simple and straightforward, yet complete, interface to Maxwell from within C4D. 
The complete list of items you use to build Maxwell scenes and render them is very short; in fact, there are only seven: 

 
 

  Scene  
 
The Scene object holds the parameters used to define a Maxwell Scene; that is, it contains the values which will be written into the MXS files it 
produces. It also contains parameters used to determine how and where the Scene is to be rendered. You may create as many Scene objects as 
you wish. When you render with the plugin, you always do so using a Scene object – the commands for rendering are an integral part of the 
Scene’s Attribute Manager interface. A Scene always exports in its own thread, allowing you to keep working in C4D while the export is running.  
 

  Material  
 
The Material object works similarly to any other C4D material. It may operate with its MXM Linking mode enabled or not. When enabled, the 
Material will automatically link to the specified on-disk MXM file; otherwise, it will behave as an ‘embedded’ Material.  
 

  Material Editor 
 
The plugin implements a native-to-C4D Material Editor which is designed to work in a way very similar to Maxwell’s MXED MXM editor.  

  Instance 
 
The plugin provides a custom Instance object for use in creating scenes which use Maxwell’s instancing system. The Instance object is as 
lightweight as possible, to enable the use of great numbers of them without slowing down C4D.   
 
Note: in Cinema 4D R11.5+, Cinema Instances which have the ‘Render Instance’ option enabled are treated much the same as this Maxwell 
Instance Object. 
 

  MXS Reference 
 
The MXS Reference node allows external Maxwell MXS files to be linked in at export-time. This is useful for keeping performance up and memory 
usage down during design-time, since the geometry in the MXS file need not be physically inserted into the current document. 
 

  Camera tag  
 
A Camera Tag may be attached either to a C4D camera object, or to a Maxwell Scene object. While the physical attributes of the camera, when 
written into the MXS, are taken from the physical characteristics it has in C4D, the Camera Tag is used to control the Maxwell-specific aspects of 
cameras which have no correlation in C4D. In all cases, the resolution of the export is taken either from C4D’s Render Settings, or from the size of 
the active viewport, depending on which command is used to start the export. 
 

  Object Properties tag  
 
Add an Object Properties tag to an object in C4D to obtain control over the various Maxwell ‘Hide from X’ mesh attributes.   
 

  Rendering Region tag  
 
A Rendering Region tag may be added to either a C4D camera object, or to a Maxwell Scene object. If one is found during export, it will be used 
to constrain the render engine to process only the specified portion of the image.  
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Maxwell for Cinema 4D :: Plugin Quick-Start 
 
 
It is entirely possible to render with Maxwell using only a Scene object. The plugin will automatically convert native C4D materials into Maxwell 
materials at export time, if there are no explicit Maxwell Materials assigned. This is not recommended, of course, as automatically-created 
materials are not likely to look as good or perform as well as custom Maxwell Materials. 
 
Similarly, it is not really necessary to create a Camera tag, unless you wish to use Maxwell-specific features like Z-Clip. All of the commonly-adjusted 
parameters of a camera are inferred either from C4D’s Render Settings, or from the Scene’s Default Exposure group, found in the Output tab. The 
Object Properties and Rendering Region tags are also strictly elective, as their basic purposes are to exclude information. 
 
So, to begin with, all you really need to do is create a Scene. To do that, click ‘Scene’ in the plugin’s main menu: 
 
 

 
 
 
In the C4D Attribute Manger, you should now see this: 
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This is all you need to render using all of the default settings. If you were to have a simple model already built when you created the new Scene, 
clicking on the ‘Render Render View’ (the first button) would get you an image something like this: 
 
 

 
 

 
As you can see, the defaults use Maxwell’s Physical Sky and Sun. Possibly, this image is a bit too ‘bright’ for your taste – that is easy to change – just 
use the parameters in the ‘Default Exposure’ section of the Scene: 
 
 

 
 

 
Adjust the EV (Exposure Value) parameter to 15, since the objects in the scene are a bit bright. After doing so, render again: 
 
 

 
 

 
Too dark now, let’s try EV=14: 
 
 

 
 

 
As you can see, the EV parameter makes it very easy to adjust the exposure – higher numbers are required for brighter environments, and vice-
versa. There is a chart at the end of this manual with suggested EVs for different scenarios. 
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Now, let’s apply some Maxwell Materials. The easiest way to do this is to use the C4D Content Browser and Material Manager. Browse to your 
Maxwell program directory (you have already installed Maxwell, or else you would have gotten an error the first time you clicked render), then to 
one of the material folders inside of the materials database/mxm files directory. Just drag any .mxm file from the Content Browser over into the 
Material Manager – once it is in the C4D document, you can drag it onto objects just as with any other material. Here, I have changed the scene bit 
and assigned two Maxwell Materials: 
 
 

 
 

 
Moving back to the camera side of things, let’s create some DOF (depth-of-field) in this image. First, what is needed to do that? Probably, the scene 
will need to be smaller; go to Cinema’s Preferences > Units and change the Basic Units to Centimeters (the cubes should be a few cm in size now). 
Also, we will want to open up the Maxwell camera’s aperture a bit, so change the fStop (it’s located directly under EV in the Default Exposure 
group) to 2.7. When ‘Lock exposure to EV’ is checked, it is possible to adjust fStop without also affecting the exposure of the image; the plugin will 
maintain a consistent EV, regardless of the chosen fStop. Here’s what we get after making these changes: 
 
 

 
 

 
Okay, so we are seeing some DOF here, but unfortunately, none of our subjects is in focus. Let’s add a C4D camera so that we can change the 
camera’s focal distance. Add the camera, set the active viewport to use it, and then drag the focal distance to the place we want to be in focus; I’ll 
use the cube in the background: 
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Moving the camera’s focus to the cube in the foreground, we get this: 
 
 

 
 

 
Keep in mind; the only Maxwell-specific objects we’ve created up to this point are a Scene and two Maxwell Materials. Let’s use some of the other 
Maxwell objects; right-click the C4D camera (or the Scene object) and add a Maxwell Camera tag. This tag will override what we’ve set up in the 
Scene’s Default Exposure group, so set the Exposure to match what we’ve set up there. Then, enable the Z-Clip planes and adjust them so they cut 
away part of the geometry: 
 
 

 
 

 
Now, let’s add a Rendering Region.  Again, right-click the C4D camera (or the Scene object) and add a Maxwell Rendering Region tag. In the 
Attributes Manager, adjust the Left, Top, Width, and Height to specify the region which should be rendered: 
 
 

 
 

 
Note, due to the way that C4D draws things in your viewport; it will be easier to use the Rendering Region if the object it is attached to is near the 
bottom of your object hierarchy in the C4D Object Manager.  
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Moving on, let’s remove the Maxwell Camera and Region Rendering tags and try out an Object Properties tag. Right-click one of the cubes and add 
the tag. Adding it to the blue cube, and enabling the ‘Hide from Camera’ checkbox results in an image like this: 
 
 

 
 
 
All of the ‘Hide from X’ settings in the Object Properties tag are fairly self-explanatory; just consult the regular Maxwell Render manual for more 
details on what they are used for. Besides for those tags, the Object Properties tag also has a switch for disabling Motion Blur. Before we use 
that, let’s just try using Motion Blur. Disable the ‘Hide from Camera’ checkbox in the Object Properties tag and select the Scene again. In Scene > 
Output > Options, enable the ‘Object Motion Blur’ option. Next, define two key frames and positions for the objects. Set the timeline to a frame 
such that the objects would be located elsewhere in the previous frame; then, render the Scene: 
 

 

 
 

 
Now, select the Object Properties tag again and check the ‘Disable’ checkbox in the Motion Blur group; then, render again: 
 
 

 
 

 
Now, to switch gears a little, let’s change from using Physical Sky and Sun, to using an Image Based Environment. Go to the Scene’s Environment 
tab, un-check the ‘Sun’ checkbox, and choose Image Based from the Type drop-down. The interface will change to show you settings for Image 
Based Environment. By default, the Scene will have the ‘Use Background for all Channels’ enabled – you only need to un-check this if you want to 
use different HDR images in the Background, Illumination, Reflection, and Refraction Channels. Many times that is not necessary though, and you 
can just let the plugin copy the settings from the Background Channel into the others at MXS-export time. 
 
So, click on the […] browse button in the Background Channel group to select a HDR image to use. Once you do, the Background Channel group will 
expand, showing the Scale, Offset, and Intensity parameters. Usually, you may not need to change these values. What you may want to do though 
is to check the ‘Show in viewport’ checkbox near the top of the Image Based Parameters section – this will allow you to preview the HDR image in 
the C4D viewport. 
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Here is how the Scene renders (after disabling ‘Object Motion Blur’) using the Image Based Environment: 
 
 

 
 

 
It was also necessary to adjust the EV down to something more like 9, since there is less light in this scenario.  
 
To wrap things up, let’s texture one of these objects using the Maxwell Material that is applied to it. 
 
First, we should select the Material, and then go to the Attribute Manager and un-check the ‘Link to’ checkbox under MXM Linking. The reason for 
doing this is because when a Material is created by dragging it from the Content Browser, it will be set to link with the MXM file which was 
dragged. As such, any changes we make to that Material in C4D will be lost next time we open the document, because the Material will 
automatically update itself using the MXM file it links to. We are going to add a texture, so we do not want this. 
 
After turning off MXM Linking, double-click the Material in the Material Manager to open the plugin’s Material Editor; this Material will be selected 
and shown in the editor. In the layers tree on the left side of the Material Editor, select one of the BSDF layers in the Material: 
 
 

 
 

 
Now, click the texture-browsing button for the Reflectance 0 channel and use the Texture Editor to choose a texture. Next, set a texture to use in 
the Bump channel, and then set the Bump value to 5. Click the ‘Refresh Preview’ button, located to the lower-right of the Material’s preview image 
to refresh the preview. Next, click the small ‘eye’ button next to the ‘Refresh Preview’ button; this will show a list which allows you to set one of 
the Material’s textures as ‘active’: 
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Once you select one of the textures, it will be shown in the viewport. You can switch which texture is shown at any time, or choose the ‘(none)’ 
item to show the Material’s basic color again. Rendering with the newly-textured Material results in this image: 
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Maxwell for Cinema 4D :: Frequently Asked Questions 
 
Question: Why does the plugin tell me it can’t find a necessary directory? 
 
On Windows, the Maxwell installer creates an environment variable named MAXWELL2_ROOT, and sets its value to point to the Maxwell 2.0 
installation directory on your machine. This allows plugins to find Maxwell. If the plugin has told you that you do not have a MAXWELL2_ROOT, it 
probably means that you either have not installed Maxwell Render 2.0, or that the Maxwell installer was unable to set the variable correctly.  
 
To resolve this, go to Start > right-click My Computer > choose Properties > go to the Advanced tab > and click the Environment variables button.  
This should get you to a window like this: 

 

 
 
Make sure that there is a System variable named MAXWELL2_ROOT, and that it points to the Maxwell folder on your machine. Also, make sure if 
there are MAXWELL2_ROOT variables in both the User and System sections that they both point to the same directory, otherwise the plugin may 
not be able to find your real Maxwell directory. 
 
If you get this message on OSX, it means that OSX cannot find the Maxwell 2.0 application directory. Check your installation (and the trash) to make 
sure that you do not have multiple Maxwell installations. 
 
Question: Why don’t my emitters seem to emit any light? 
 
Most likely, you are not modeling using a realistic scale. Maxwell is based on physical reality, and its camera requires the objects it is capturing to 
be modeled at a realistic scale. Similarly, Maxwell emitter materials are defined using real-world units. If you are not modeling at a realistic size, the 
correlation between the surface-area which is emitting the light and the total power output of that light will not match, and you will either have 
emitters which are much too bright, or much too dark. Put another way – if you spread 40 watts of energy over a surface the size of a football field, 
how much light will you see coming from one square foot of that field? Probably none, or nearly so.  
 
Question: How can I preview HDR images in the C4D viewport? 
 
Create a Scene object, go to its Environment tab, set the Environment Type to ‘Image Based’, select a HDR image using the Background Channel’s 
path browse button, then check the ‘Show in viewport’ checkbox. 
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  Maxwell for Cinema 4D :: Scene (object) 
 
 
Exporting and rendering of MXS files with the Maxwell for Cinema 4D plugin is always accomplished through the use of a Scene object. A new 
Scene is created using the ‘Scene’ item, found in the plugin’s main menu: 
 
 

 
 
 
A C4D document may contain as many Maxwell Scene objects as you wish. Each Scene holds a complete set of parameters, and the values for any 
given Scene object are used when that Scene is exported to an MXS file. The various parameters are divided into four basic tabs: 
 
 

 
 
 
 
Output:  contains parameters which affect properties of the MXS file being exported, and how that export is to be accomplished. 
 
Engine:  contains parameters related various options exposed in the Maxwell rendering engine, Maxwell Render. 
 
Environment:  contains parameters related to the MXS environment, i.e. whether the Scene will use the Maxwell Sky Dome, Physical Sky, or 

Image Based environmental lighting. 
 
Cinema:  contains parameters which control how the plugin exports native C4D lights and procedural textures, as well as a global scale 

modifier you can use to scale the exported mesh geometry. 
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At the top of the Scene object’s user-interface, you will find several buttons which are used for exporting that Scene to MXS files and rendering in 
various ways: 
 
 

 
 
 

  Render (Render View & Active View) 
 

The ‘Render Render View’ button exports this Scene to an MXS using the resolution defined in C4D’s Render Settings > Output section. The 
‘Render Active View’ button does the same, but uses the resolution of the active viewport. When the export is finished, the resulting MXS file is 
then rendered using the Maxwell Render render engine. If these buttons are disabled, it means that the plugin was unable to locate Maxwell 
Render  on your system; in that case, you should check that Maxwell Render is properly installed (see the MAXWELL2_ROOT FAQ). 

 

  Export to Studio 
 

This button exports this Scene to an MXS file and then opens it in Maxwell Studio. If this button is disabled, it means that the plugin was unable 
to locate Maxwell Studio  on your system; in that case, you should check that Maxwell Render is properly installed (see the MAXWELL2_ROOT 
FAQ). 
 

 Export to Network 
 

This button exports this Scene to an MXS file and then sends it to the Maxwell Network Render system. 
 

  Export MXS 
 

This button simply exports this Scene to an MXS file.  
 

  Send to Maxwell Fire 
 

This button exports and links this Scene to Maxwell Fire.  
 
 

In addition to these per-Scene MXS-export controls, the plugin also provides duplicates located in the plugin’s main menu/toolbar: 
 
 

 
 
 
These commands will act on the Scene which was last ‘touched’; if no Scene has yet been created or selected, these commands will be disabled. 
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Scene :: Output 
 
 

 
 

 
The Output tab contains several groups which control how MXS files are written and exported. 
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Output (main group) 
 
 

 
 

 
 
This group contains parameters which control where the files created by the plugin and Maxwell will be written. 
 

Name 
 
This is the name which will be used to generate the various filenames required to write MXS files. This includes the file name of the MXS file, the 
image-output file, and the MXI file. This should be specified as a name with no extension; the appropriate extensions will be inserted as 
necessary by the plugin. The Name should therefore also not contain characters which are illegal for use in file paths. If no name is entered here, 
the plugin will first try to use the Output Name specified in the Preferences page, or else it will try to use the current document name. The image 
format (the main RGB output) which will be written may be chosen from the drop-down list 
 
Folder 
 
This is the root folder used for the plugin’s output. MXS, image, and MXI files will be written to this location. If procedural textures need to be 
exported, they will be written into a ‘textures’ folder located inside the one specified here. If no folder is specified here, the plugin will try to use 
the Output Folder specified in the Preferences page, or else it will try to use the current document location. If it is unable to determine the 
current document location (for example, when the document has not yet been saved), it will try to use the current directory, which will likely be 
either the location of C4D itself, or the location it was started from. To open the current output folder, just click the folder button at the right. 

 
 
Export Options 
 
 

 
 

 
 
This group holds parameters which affect how the exported MXS file will be written. 

 
 
Disable Maxwell Instances  
 
This option simply disables the export of Maxwell Instance objects on a global basis.  
 
Auto-generate instances  
 
This option is not related to the Maxwell Instance Object provided by the plugin. Rather, what it does is to automatically identify objects which 
are candidates for instancing during export. For example, if there are two cubes in the scene, both with the same name and mesh-topology, then 
only the first will be exported as a mesh – the second will automatically be exported as an instance in the MXS. This is suitable for use with things 
like emitters, which generate a great number of similarly-named objects, the topology of which is identical between instances, with the only 
difference being each object's transformation. 
 
Protect MXS  
 
This option determines whether or not Maxwell Studio will allow the meshes in the MXS being written to be exported or not. If this is enabled, 
the MXS will be ‘locked’; that is, third-parties will not be allowed to extract meshes from the MXS via Maxwell Studio, thereby providing a way of 
providing third-parties with actual MXS files for various purposes while still offering some protection of the intellectual property they contain. 
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Pack and Go  
 
When this option is activated, the plugin will scan through all files referenced in the scene (i.e. texture, ior, hdr, etc.) and copy them to the 
output directory during export. The paths contained in the exported mxs will point to the new copies, rather than the original files. This makes it 
much easier to transport an entire scene to another location. 
 
 

 
Motion Blur & Animation 
 
 

 
 

 
 
This group is only shown when the ‘Export Animation’ option is enabled. When a Scene is exported with Animation enabled, the plugin will cause 
the C4D document to be animated, exporting a sequentially-named MXS file for each frame. There are a few parameters which control how the 
animation export is done. 
 
 

Pre-roll Timeline  
 
When this option is enabled, the plugin will animate the document through all frames prior to the one being exported. This can be helpful, as it 
makes sure that all generators and expressions have been properly run, ensuring a consistent result at the current frame. This is not free (that is, 
it can take some time to run the document through its frames) so only enable this option when necessary. 

 
Shutter-based Blur  
 
When enabled, the amount that objects and cameras will be moved along the timeline is figured based on the shutter value of the camera being 
exported. So for example, given FPS (specified in Cinema Render Settings, not the camera) of 24 and a shutter speed of 1/24, each object will 
appear to move one frames-worth of movement along the Cinema timeline. Given a shutter of 1 second, the object will appear to move 24 
frames, with the movement being centered on the frame being exported.  
 
Export Animation  
 
This option determines whether or not the plugin will export in single- or multiple-frame mode. The Animation group is not shown in the Scene 
user-interface unless this option is enabled. 
 
Camera Motion Blur  
 
Similar to the Object Motion Blur option, this controls whether or not to export Motion Blur information for the camera.  
 
Object Motion Blur  
 
When this is enabled, the plugin will move objects backward and forward along the timeline in order to figure Motion Blur. When Shutter-based 
blur is enabled, the amount that objects are moved will be dependent on the shutter value of the camera being used. Otherwise, objects will be 
moved half of a frame forward and backward, in reference to the frame currently being exported.  
 
Motion Blur Steps 
 
This number determines how many times the plugin will sample the exposure range for object positions when calculating object motion blur. If, 
for example, this value is set to 2, then only the starting and ending positions of objects will be written. More positions will cause the motion blur 
to more closely follow objects which move arbitrarily during the exposure. 
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Animation Frame Range 
 
 

 
 

 
 
This group is only shown when the ‘Export Animation’ option is enabled. When a Scene is exported with Animation enabled, the plugin will cause 
the C4D document to be animated, exporting a sequentially-named MXS file for each frame. There are a few parameters which control how the 
animation export is done. 
 
 

Use Render Settings  
 
This determines whether to use the frame-range and step count set in the active C4D Render Settings, or to use a custom range.  
 
Step  
 
This parameter controls how many (if any) frames to skip between MXS exports. If this is set to one, all frames will be exported, whereas if it 
were set to two, one frame on the timeline would be skipped for each one that was exported. If the animation frame range was ten, and the 
Step size was also set to ten, then only one frame would be exported. 
 
Render from…to  
 
When the ‘Use Cinema Range’ option is disabled, these inputs control the range of frames which will be exported. If the ‘to’ value is less than the 
‘from’ value, the animation will be done in reverse – under these circumstances, Motion Blur will also be figured in reverse, if it is enabled. 

 
 

Default Exposure 
 
 

 
 

 
 
Most of the parameters for the camera which appears in the exported MXS are taken directly from the C4D camera’s physical properties, and 
certain aspects of C4D’s Render Settings. Even so, a C4D camera lacks some features which are integral to the way that Maxwell works; for the 
most part, these are related to exposure. This group contains parameters which will be used to control the exposure when no actual Maxwell 
Camera Tag is found at export time. 
 
For information on these parameters, please see the Camera Tag topic on page 47. 
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Render Channels 
 
 

 
 
 
Options in this group control the various different image outputs which may be rendered by Maxwell Render. 'Render'is the main output image. 
The other channels are used for compositing in a third-party application like Photoshop – see the main Maxwell Render manual for more details on 
the various channels. 
 
Scene Presets 
 
 

 
 
 
A complete Maxwell Scene object may be saved to an external XML file for later use, or for sharing.  
 
Additionally, the plugin uses a preset file named ‘default_scene.xml’, which may be found in the plugin’s /res directory to set the default values for 
each new Scene object you create. This makes it easy, for example, for a multi-user office to make sure that all of the machines using the Maxwell 
for Cinema 4D plugin are using identical default settings – they just need to distribute new ‘default_scene.xml’ files to each machine. 
 
Note: if you have used C4D’s own ‘Save as Default’ option with a Maxwell Scene, the settings contained in your ‘default_scene.xml’ file will no 
longer have any effect. To reverse this, remove the Scene from your defaults folder. 
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Scene :: Engine 
 
 

 
 

 
The Engine tab contains several sub-groups which control parameters used by the Maxwell Render render engine, 
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Engine (main group) 
 
 
 

 
 

 
 
This group contains parameters which affect various aspects of the rendering engine (i.e. Maxwell Render) itself, which is a standalone application 
that runs in a separate process from the host application and plugin. 
 

 
Render time 
 
This is the maximum time Maxwell Render will render before stopping. As it is possible to stop Maxwell Render at any time, it is generally best to 
leave this set to a higher number of minutes than will be necessary to obtain a clear image. 
 
Sampling level 
 
Maxwell Render will stop when it reaches this SL (Sampling Level), or the Render time value, if the specified SL is not reached before the Render 
time has elapsed. 
 
CPU Threads 
 
This parameter specifies how many threads will be spawned by the Maxwell Render render process. Setting this to zero will cause Maxwell 
Render to auto-detect and render using all available CPU resources. Setting the number of threads to [CPU count – 1] represents a trade-off 
between rendering speed and machine responsiveness, in case the machine must be used for other purposes while rendering. 
 
Command line 
 
The plugin (like all Maxwell plugins) does not directly contain any rendering functionality. Rather, it is an MXS file exporter. To render the MXS 
files it produces, it uses the Maxwell Render rendering application. Maxwell Render runs from a command line, and different command-line flags 
are supplied by the plugin to start it rendering on an exported MXS file. In addition to the flags passed by the plugin, you can also enter any other 
Maxwell Render command-line flags you wish in this text box, and they will be added to the flags that the plugin gives Maxwell Render. 
 
Quality 
 
Determines whether to use Maxwell Render's production or draft (i.e. the same engine used in Maxwell Fire) engine. 
 
Priority 
 
Determines whether or not Maxwell Render will be started as a low-priority process. This is the same as adding  –p:low to the command-line. 
 
Multilight 
 
Maxwell’s Multilight feature allows you to control the intensity of your lights while you render, or after you have finished rendering. Two modes 
are provided: Intensity and Color. Note that it takes a great deal more memory to use this feature, so do not enable it if you do not intend to use 
it. 
 
MXI Output 
 
Determines whether Maxwell Render will write a single MXI file, one for each light, or none at all. 
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Fire Options 
 
 

 
 

 
Sampling Level and Threads directly control their parameters in the Fire render engine, while the Quality parameter determines the actual size of 
the image being rendered (the image is interpolated to fit the current size of the Fire window). 

 
 
Tone Mapping 
 
 

 
 

 
These parameters correspond to those of the same name as seen in the Maxwell Render user-interface. For technical details on the meaning of 
these parameters, see the main Maxwell Render manual. 
 
SimuLens 
 
 

 
 

 
Maxwell Render provides access to the image-enhancing features known as SimuLens.  
 

Aperture & Obstacle Maps  
 
These maps are used by the SimuLens Diffraction feature, if they are specified. Several example maps may be found in the 'Simulens maps' folder 
inside the Maxwell folder on your machine 

 
Diffraction  
 
SimuLens is able to simulate camera lens-diffraction effects. it is not recommended to enable Diffraction from the plugin, since Maxwell Render 
will apply it at each image update – rather, wait until the image is finished and apply Diffraction using Maxwell Render. 
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Scattering  
 
This parameter simulates light-scattering caused by the camera’s lens. Since this scattering is figured by Maxwell Render at each image update, it 
is recommended (in the interest of reducing render-time) to leave this disabled, then apply it to the final image via Maxwell Render’s user-
interface when the image has finished rendering. 
 

Devignetting  
 
By default, Maxwell Render simulates realistic vignetting (i.e. the darkening around edges of images); to disable this, check the Devignetting 
option and set the reduction value between zero and one-hundred percent to vary the amount of vignetting seen in the final output image.  
 

 
 
Materials 
 
 

 
 

 
 
Setting the path to an MXM file in the Override material field will cause all non-emitter objects to be rendered using this MXM rather than 
whatever they may have explicitly assigned. The Default path can be used to set which MXM should be used for objects which have no explicit 
material assigned. If it is blank, a standard 153,153,153 diffuse MXM will be created under your user folder and the path to it will be given to 
Maxwell Render to use as default for non-assigned objects. 
 
 
Render Layers 
 
 

 
 
 
 
Though Maxwell naturally calculates all possible light interactions in a scene, it is possible to inhibit certain types of calculation using the toggles 
found in this section. The specific light-interactions which each of these options affect should be fairly self-explanatory, for more details, see the 
regular Maxwell Render manual. 
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Scene :: Environment 
 
 

 
 
The Environment tab controls the environment which will be used in the exported MXS, and contains all of the parameters necessary to control 
each Environment Type. There are four types of environment available; Sky Dome, Physical Sky, Image Based, and None. The environment for a 
Scene is set by using the drop-down list contained in the main Environment group. The Sun may be enabled regardless of which environment type 
is chosen. When the Sun is enabled, the Sun Indicator group will be shown: 
 

 
 
When the Sun Indicator is enabled, the direction of the Sun will be shown in the viewport, using a yellow line and sphere. As date, time, location, or 
Scene Rotation is changed, the indicator will be updated in real-time, allowing for an intuitive prediction of where shadows will appear in the 
rendered image: 
 

 
 
Use the Sun Indicator’s Scale Factor to adjust how far away from the Scene Object’s origin the sphere will be drawn. The indicator may be moved to 
a convenient location by changing the position of the Scene Object; the indicator is drawn relative to this location. 
 
Additionally, if a light with a Sun Expression tag is found during export, then the position of the object controlled by the expression will be used to 
set the Sun’s direction in Maxwell, rather than what is specified in the Scene Object being rendered. 
 
Sky Dome Parameters 
 
 

 
 

 
When Sky Dome is chosen as the Environment Type, the scene will be lit by a sphere of light. The intensity, zenith, and horizon colors are 
individually controlled using the parameters of the same names. The Mid Point parameter determines the angle from the horizon at which the 
horizon and zenith colors are evenly mixed. 
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Physical Sky Parameters 
 
 

 
 

 
When Physical Sky is chosen as the Environment Type, the scene will be lit by an all-encompassing dome of light generated by Maxwell to simulate 
the appearance of a natural sky. How this sky appears is controlled by a set of parameters divided into three basic groups: 
 
 
 Sun Parameters: control the power and color of the Sun and the basic reflectivity of the planet 
 Gas Parameters: control the amount of ozone and water vapor in the air 
 Aerosol Parameters: control the characteristics and concentration of particulates in the air 
 
 
Physical Sky parameters may also be loaded or saved using Maxwell .sky files, just click the ‘Load’ or ‘Save’ buttons. Note, .sky files hold more than 
just atmospheric data; they include the date, time, location, and whether or not the Sun is enabled. 
 
 
Sun temperature:  Temperature of the sun’s spectral radiation. The default value of 5777 is the most common value measured 

outside the Earth’s atmosphere. 
 
Sun power:  A multiplier that controls the amount of light emitted from the sun. Higher values than the default 1.0 will make 

the sun emit more light, lower values will emit less. 
 
Planet reflectance:  Controls the percentage of light reflected from the planet surface back into the atmosphere. 
 
Turbidity Coefficient:  Defines the concentration and amount of particles in the atmosphere. A value of 0.0 means a perfectly clear sky 

(in which case the next three parameters won’t have any effect). 0.01 is a good value for low turbidity, e.g. a sky 
containing very few aerosols, which will appear almost clear. 0.040 is a good medium value and 0.3 is a fairly 
high value.  

 

 
Turbidity Coef. 0.0, Turbidity Coef. 0.04 Turbidity Coef. 0.3 
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Raising the turbidity coefficient in sunset situations will darken the sky. Remember that you can also alter the EV 
of the camera in these cases, which can create an interesting sky:  

 

 
Turbidity Coef. 0.0, EV=15 Turbidity Coef. 0.1, EV=15 Turbidity Coef. 0.1, EV=12 
 

 
Wavelength Exponent:  Defines the average size of the particles in the atmosphere. The particle size influences which wavelengths of 

light are absorbed and which are scattered. Higher values than the default will increase the saturation of the sky, 
until gradually it turns first green and then orange:  

 

 
Wavelength Exp. 1.2 Wavelength Exp. 5.0 Wavelength Exp. 10.0 

 
 
Reflectance:  Refers to the albedo of the aerosols, or the rate of energy scattered and absorbed by the aerosols. 
 
 
Scattering Asymmetry:  This factor controls the anisotropy of the particles, that is, in which direction most of the light will be scattered. 

Positive values will produce a halo effect around the sun, brightening the area around it: 
 

 
Scattering Asym. -0.7 Scattering Asym. 0.0 Scattering Asym. 0.7 

 
 

Ozone:  the amount of ozone gas in the atmosphere, measured in the centimeter-height of a column of atmosphere. The 
default value is 0.4. 

 
Water:  The amount of water vapor in the atmosphere. It is measured in centimeters, in the same way as ozone. 
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Location & Time 
 
 

 
 

 
The Location & Time group will be shown whenever it is applicable, i.e. when any of the following conditions are true: 
 
 the Sun is enabled 
 the Environment Type is Physical Sky 
 the Environment Type is Image Based, the Image Based environment uses Physical Sky for disabled channels, and there are disabled channels 

or channels with invalid paths 
 
The Latitude and Longitude parameters may be set manually, or automatically, by choosing a city from the drop-down list. GMT (Greenwich Mean 
Time) will be figured automatically by the plugin regardless of how the location is specified. The Ground Rotation parameter rotates the 
environment in a range from 0 to 360 degrees, allowing you to change which direction is North without physically changing the C4D scene. 
 
 
Export Environment as HDR 
 
 

 
 

 
The Physical Sky may be exported to an HDR file. Clicking ‘Export’ will export an HDR using the resolution set in C4D’s Render Settings, while 
clicking ‘Export Viewport’ will export using the active viewport’s resolution. Enable the ‘Use custom resolution’ option to export an HDR using a 
custom size. 
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Image Based Parameters 
 
 

 
 

 
The Image Based Environment Type allows you to light the scene using HDR images. There are four Image Based Channels provided:  

 
 Background:  this image will be seen where the background is directly visible to the camera 
 Illumination: this image will be used to illuminate the scene 
 Reflection: this image will be seen in reflections in the scene 
 Refraction: this image will be seen where light is refracted in the scene 

 
Each channel shares a few similar parameters and a similar operation:  

 
 Source: sets whether the channel uses a file, the active Sky, links to the Background Channel, or is disabled 
 Path: this is the path to an .mxi, .hdr, or .exr file which will be used in the channel 
 Scale U/V: scales the input image in width and height such that n-number of tiles will be fit into the mapped area 
 Offset U/V: shifts the image up or down by n-percent 
 Intensity: alters the basic output power given to this channel’s image 
 Screen Mapped:  this parameter is only present in the Background channel. It causes the Background channel to be mapped flat against the 

image plane, rather than spherically. This mode cannot be shown in the C4D viewport 
 
Parameters which have no context, given the state of other parameters, are not shown. For example, until a channel’s path has been set to point to 
a valid file, nothing is shown for that channel except for the path chooser. When a path has been specified, but the channel is not enabled, all of 
the parameters, except for the path and the ‘Enabled’ checkbox, will not be shown.  
 
Besides for these per-channel parameters there are a two other main parameters available in the Image Based Environment Type: 
 
Use Interpolation  

This option turns on render-time pixel-interpolation for environment HDR images. 
 
Intensity Multiplier  
 
The Intensity parameter of all image-based channels will be mulitplied by this value. 
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Viewport Display  
 
Determines which channel, if any, to display in the C4D viewport. 
 
Image Based Sky Type  
 
This drop-down is only shown when necessary; it determines the type of environment to use for channels which are either disabled, or are 
explicitly set to use the active sky. 
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Scene :: Cinema  
 
 

 
 

 
The Cinema tab contains parameters which tell the plugin how to deal with native C4D objects that have no correlation in Maxwell Render itself, 
and therefore require some sort of translation. 
 
 
Cinema (main group) 
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Export Units 
 
The output of the Scene will be scaled using this value. If it is set to ‘Cinema Basic Units’, objects will be exported at the size they are drawn in 
Cinema, according to the Basic Units setting in Cinema’s Units preference page. There are several other scale presets available as well: 
 
 

  
 
 
If any of the named presets are chosen, then the document will be exported such that a unit specified in the Cinema UI, no matter what the Cinema 
Basic Units setting, will be treated as the unit chosen here. So, though the Cinema UI may be showing the width of an object as 200mm, choosing 
Inch here will result in the object being exported at 200 inches wide. Similarly, if you choose Custom here, a numeric input will be shown: 
 
 

 
 

 
In this case, the values specified in the Cinema UI will be interpreted as meters, and will then multiplied by the given value; so as shown above, the 
exported size of the 200-unit wide object will be 200 meters X 0.01, or two meters. 
 
 
Lights 
 
 

 
 
 
The Lights group contains parameters which control how the plugin translates native C4D lights into mesh-geometry in the exported MXS file.  
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Create Physical Lights  
 
Enables or disables the translation of native C4D lights into meshes and emitter materials during export.  
 
Hide from Camera/Hide from Reflections and Refractions 
 
This determines whether or not the meshes generated will have the Maxwell object-flags of the same names set. This is useful for when you 
have C4D lights which would be visible to the camera, either directly or indirectly, and you wish them not to be.  
 
Omni-light segments  
 
Determines the number of radial segments which will generated omni-light meshes will have. Do not use more detail here than necessary, since 
Maxwell render-time is adversely affected by emitter-geometry with large numbers of individual mesh-faces.  
 
Omni-light radius  
 
This determines the radius given to the sphere generated for an omni-light.  
 
Round spot-light segments  
 
Similar to the ‘Omni-light segments’ parameter, this controls how many radial segments will be used when generating spot-lights. Spot-lights are 
slightly more efficient in this regard than omni-lights, since the plugin can generate a simple disc for the spot-light’s emitter mesh, rather than an 
entire sphere. 

 
 

Procedurals 
 
 

 
 

 
Maxwell always uses textures which are specified as a path to an on-disk image file. As such, the plugin must render any C4D procedural textures 
out to disk when it performs automatic conversion of C4D materials to Maxwell materials during export. The parameters in this group are used to 
control how those procedural textures are rendered.  
 
 

Render to disk  
 
Enables or disables the export of C4D procedural textures. When enabled, procedural textures found in native C4D materials during export will 
be rendered out and saved to files placed in a ‘textures’ directory, under the location specified in Scene > Output > Folder. 
 
Use Interpolation 
 
Enables or disables the Maxwell texture’s ‘interpolation’ option for all generated textures. 
 
Sampling Size/Width/Height 
 
This sets the resolution that native C4D procedurals will be saved to during export. Choose one of the pre-defined sizes from the drop-down, or 
choose ‘Custom’ and set the desired size using the Width and Height parameters 
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  Maxwell for Cinema 4D :: Material (material) 
 
 
To create a new Maxwell Material, either use C4D’s Material Manager (as with any material), or click the ‘Material’ item in the plugin’s main menu. 
 
Plugin Materials and Maxwell MXM Files 
 
Firstly, it is important to recognize that there is a difference between an MXM file on your hard disk and a Maxwell Material contained in a C4D file 
– they are not the same thing, though they are very similar. It is necessary for the plugin to have its own ‘version’ of Maxwell MXM materials, so 
that it can save them directly inside of C4D documents. If it did not do so, Maxwell materials could only exist as file paths stored in the document 
which reference MXM files on your disk. While this is entirely possible to do, and even preferable for some workflows, it means that in addition to a 
C4D file, you also need to bring along any number of physical MXM files with you when you want to transfer a document from one machine to 
another. Furthermore, it is prone to error, since directory structures most likely will not match from one machine to the next, and this often results 
in broken MXM links, and material assignments which do not produce any valid Maxwell material during export. 
 
As such, a Maxwell Material in the Maxwell for Cinema 4D plugin may operate in one of two modes: either linked to an MXM file on your machine, 
or embedded directly in the C4D document. To control whether a Material behaves as linked or as embedded, use the MXM path and ‘Link to’ 
options in the Material’s C4D Attribute Manager interface: 
 

 

 
 
 
When a material is linked to an MXM file, the ‘Material Editor’ button will be disabled; linked materials must be edited using Maxwell MXED. 
Similarly, the user-interface shown in the plugin’s Material Editor window will be the same as what is found in Cinema’s Attribute Manager; this is 
done for the same reason – any edits made to the linked material would be lost next time the document was opened. To understand why this is the 
case, continue reading about MXM Linking on the next page. 
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In order for a Material to use Linked mode, it is necessary that its MXM path points to a valid MXM file. When this is true, and the Linked mode is 
enabled, the Material’s preview will appear (in the Attribute and Material Managers and in Texture Tags) with a green border: 
 

 
 
 
If a Material is set to use Linked mode, but the specified MXM file is not able to be found, it will appear with a red border: 
 

 
 
 
If a Material is not set to use Linked mode, no border will appear: 
 

 
 
 
How does MXM Linking work? 

 
MXM Linking is completely optional; that is, the full definition of the Material is always stored (i.e. embedded) in the C4D document. This ensures 
that no matter where you open a C4D document, it will still be able to be rendered in Maxwell the same as it did the last time it was saved. How it 
works in practice is this: 
 
 a C4D document is opened 
 the plugin reads the Materials stored inside 
 for each Material which was saved with MXM Linking enabled, the plugin reads its MXM path, and checks whether an MXM file is found at this 

location (or at any location found in the various search paths) 
 if the MXM file is found, the Material is immediately updated with the contents of that MXM file. If however, the MXM file is not found, 

nothing further happens – the definition of the Material which was found in the document will be used at render-time 
 

Therefore, the MXM Linking feature of the plugin offers the ability to reference central MXM files in individual C4D documents, thereby allowing 
you to change how Materials in multiple documents render just by editing one MXM file, while simultaneously handling scenarios where a specified 
MXM file is not found, or where the Material is not set to reference any MXM file at all. 
 
Note that, it is possible to modify a Material using the plugin’s Material Editor, regardless if it is linked or not – these changes will not be written 
back out into any linked MXM file. If you do not wish to lose such changes (i.e. next time the document is opened, the linked MXM will be read 
again), use the ‘Export as MXM’ item in the Material Editor’s MXM Options menu. 
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  Maxwell for Cinema 4D :: Material Editor (gui) 
 
To open the plugin’s integrated Maxwell Material Editor, either click the ‘Material Editor’ button in the Material’s Attribute Manager interface, or 
click the ‘Material Editor’ item in the plugin’s main menu: 
 
 

 
 
 
This will bring up the plugin’s integrated Material Editor, which is very similar to Maxwell MXED (as noted in the MXM Linking section, a linked 
material does not show this interface; it shows the same interface as the Attribute Manager): 
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Main Menu 
 

Create: this menu is used to create new Materials. 
 

 
 
New Material  
 
This item creates a new basic lambertian Material with Reflectance 0 of 153, 153, 153. 
         
From MXM 
     
This item prompts for the path to an MXM file, which it then uses to create a new Material.  
 
Standard 
     
Creates a new Material using one of five Material templates: 
 

 
Diffuse: creates a simple diffuse Material. 
 

 
 
 
Emitter: creates an Emitter Material, using either RGB and power values, or an MXI/HDR texture, if one is specified. 
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Dielectric: creates a simple dielectric (transparent) Material. The Color value will be used as the Material’s Transmittance color, as will the 
color map, if one is specified. Specifying an Abbe value other than 160.0 will activate Dispersion in the new Material. 
 

 
 
 
Metal: creates a simple metallic Material using one of six pre-defined metals; aluminum, cobalt, copper, gold, nickel, and silver. 
 

 
 
 
Plastic: creates a two-BSDF (Color Base & Gloss) plastic Material. The basic color of the Material is specified using the Diffuse Color value, or 
the Color texture. The Specular Color value is used in the Gloss layer’s Reflectance 90 color channel.  
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MXM Options: This menu deals with Material/MXM interoperation. 
 
 

 
 
 
Import MXM Data 
 
As implied by the name, this imports MXM data into an existing Material, replacing its current state entirely. 
 
Export as MXM 
 
This item exports the current state of this Material to an MXM file. When this is done, the option is given to link the Material being exported to 
the target MXM. 
 
Edit with MXED 
 
The main purpose of this item is to give access to any advanced capabilities of MXED, which may not be available in the plugin’s own Material 
Editor. 
 
Open MXED Browser 
 
This is just a shortcut to opening the MXED MXM browser. Due to the technical details of how C4D works, drag-drop from the browser behaves 
differently depending on where MXMs are dropped. When dropped over the Material Editor’s preview image, the MXM will be imported into 
the scene. If an entire folder is dropped, the MXMs inside will be imported to the scene. It also works in a similar way when MXM files are 
drag/dropped from Explorer or Finder. Unfortunately though, when MXM files are dropped from Explorer or Finder into the C4D Material 
Manager, C4D interprets this as a File > Open operation, and creates a new C4D file rather than allowing the plugin to import them, so it is not 
recommended to drag-drop from Explorer/Finder into the C4D Material Manager window – drop them onto the Material Editor’s preview image 
instead. 
 
 
Wizards 
 
 

 
 
 
In this menu you will find a list of various material wizards, similar to those found in Maxwell MXED. When a wizard is used, and there is a 
Maxwell material currently selected, you will be asked if you would like to modify that material or create a new one. 
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Browse MXM Gallery 
 
This command opens Maxwell MXED’s MXM Gallery Browser, which allows you to search the online database of MXM materials: 
 

  
 
When you have located the MXM you would like to download, simply click the ‘Import’ button in the search window to import the selected MXM 
file into the Scene. The file will be downloaded and unzipped to one of two places: 

 
 if the current document has not been saved, the MXM and related files will be saved to [documents]\Maxwell\mxmgallery 
 if the current document has been saved, the MXM and related files will be saved to a new folder named mxmgallery, which will be created in 

the same directory as the current document 
 
During this process, all files referenced by the newly-downloaded MXM will be placed in a textures folder under the mxmgallery folder.  The 
paths inside of the MXM file will be altered to point to the new location, since many MXMs from the MXM Gallery contain paths which will not 
exist on your machine. 
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Material Overview Pane 
 
 

 
 
 
This portion of the Material Editor window is used to control the global state of the Material.   

 
Material Preview 
     
Double-clicking the preview will start a preview-refresh (as with MXED). Dragging an MXM file from the Cinema Content Browser, MXED MXM 
Browser, or Explorer/Finder and dropping it here will cause it to be imported into the scene. 
         
Select Active Texture 
     
Sets which one of this Material’s textures will be shown in the viewport (if it has any textures) using a drop-down menu. To show the basic color 
of the Material again, select (none) from the menu. 
 
Enable/Disable Real-time Preview 
 
This sets whether the material editor will refresh the preview automatically whenever a material parameter is changed. It may be useful to 
disable it when rendering in Fire, to allow your CPU to work on the Fire image without getting slowed down by attempting to keep material 
previews updated in real time. 
 
Note that for technical reasons, in C4D versions prior to R12, this option is contained in the plugin's Preferences panel (page 51), rather than 
here as a button in the material editor. 
 
Refresh Preview 
 
This button simply requests that a new material preview be rendered. 
 
Material Layers Tree 
     
Similar to the tree found in MXED, this control allows you to define the structure of the material. New components are added by right-clicking 
the desired parent component and choosing what to add (i.e. right-click a Layer to add a BSDF). Child components may be re-ordered under their 
parent by dragging them from their current position and dropping them on their parent node; this will put them at the top of the list.  
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Components may be copied by holding down CTRL while executing a drag-drop action; rather than moving the dragged component, a copy of it 
will be added to the target node. 
 
Additionally, individual components may be dragged back and forth between the Layers tree and the various pages in the Database Manager; 
this makes it easy to build new materials from pre-defined components. 

 
 

Material Page 
 
 

 
 
The parameters in this page apply to the Material as a whole. Each Material saves its own Preview Options, so that different MXS preview scenes 
may be used for different types of Materials. The MXS preview scenes listed in the Scene drop-down are those found in the Maxwell/preview 
directory. In addition to specifying individual bump maps in each BSDF layer, it is also possible to supply a bump (or normal) map here which will be 
used to affect the material as a whole. 
 

Dispersion 
 
This switch enables the calculation of dispersion. Dispersion is the ‘rainbow’ effect seen when light is split based on its different wavelengths as it 
passes through refractive materials. Enabling this option can raise render times because of the extra math involved in calculating these 
wavelength-based refractions. 
 
Matte 
 
Materials which have this switch enabled will cause the background (i.e. Physical Sky, etc.) to show through all geometry where the objects they 
are assigned to are seen by the camera. This can be useful for creating composite images. 
 
Shadow 
 
Materials which have this switch enabled will have the objects they are assigned to casting shadows when the Shadow channel is rendered (see 
Output > Render Channels > Shadow). 
 
Material ID Color 
 
This is the color which will be used for this material when the Material ID channel is rendered. 
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BSDF Page 
 

 
 
The operation of this page is similar to that of the BSDF page in MXED. When certain parameters in the page are grayed-out, it means that they 
would have no effect; they will become enabled when other parameters have been changed in such a way as to make them effective. 
 
When Reflectance > IOR is set to ‘Measured Data’, all of the parameters in the Reflectance group will be grayed out, since they have no effect in 
this case. Similarly, the min/max Thickness controls in the SubSurface group are only enabled when (a) Single Side SSS is enabled, and (b) an SSS 
Thickness map is assigned and enabled. 
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Layer Page 
 

 
 
The operation of this page is similar to that of the Layer page in MXED.  
 
 
Coating Page 
 

 
 
The operation of this page is similar to that of the Coating page in MXED. Similar to the BSDF page, the parameters in the Reflectance group will be 
hidden when Reflectance > IOR is set to ‘Measured Data’, since they have no effect in this case. 
 
 
Displacement Page 
 

 
 
The operation of this page is similar to that of the Displacement page in MXED. Note that while MXED allows a separate Displacement layer to be 
added to each Layer, the plugin does not, instead placing Displacement at the Material-level. Functionality is similar, because in MXED, one of the 
several possible Displacement layers must be chosen – in other words, only one Displacement may be specified for the material. The plugin 
therefore chooses to display this relationship as it is in the layers tree.  
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Emitter Page 
 

 
 
The operation of this page is similar to that of the Emitter page in MXED. The contents of the page change based on which Input type is currently 
selected. When Color and Luminance is selected, the page will appear as shown above. When Temperature of Emission is selected the Temperature 
of Emission slider used to set the emitter output in Kelvins will be enabled: 
 

 
 
When Image Emission Texture is selected, the Image Emission Section will be enabled: 
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Texture Editor 
 

 
 
The operation of this window is similar to that of the Texture Editor window in MXED. Changes made to all parameters except for ‘Real Scale (m)’ 
and ‘Filtering’  will be shown both here in the Texture Editor’s preview window, and also in the viewport, when this texture has been chosen as its 
parent material’s viewport texture. The ‘Preview size’ parameter determines how detailed of a texture should be generated for use in the C4D 
viewport – larger sizes will require more processor time. Each parameter also has a ‘reset’ button to make it more convenient to return to the 
default value. 
 
For convenience, the following key-modifiers are taken into account when adjusting texture parameters: 

 CTRL:  apply change to all textures in this texture’s parent component (BSDF, Coating, etc.) 
 SHIFT:  apply change to all textures in this texture’s parent Layer 
 ALT:  apply change to all textures in this texture’s parent material 
 
The browse button acts as a toggle; that is, if there is no path set, it prompts for you to select the path to an image, otherwise it clears the 
currently-set path. 
 

 
Notes on the use of the Texture Channel Parameter 
 
Maxwell Render supports multiple sets of UV coordinates on each mesh. These UV sets are referenced in the material using the Channel 
parameter; so, if an object has two sets of UVs, the decision of which to use for any given texture is determined using the Channel parameter: 
those which use Channel 0 will use the first set, while those which use Channel 1 will use the second. 
 
In the Cinema texturing system, however, there exists no explicit way of associating a single material (that is, a single Texture Tag) with multiple 
sets of UVs. The plugin introduces a method for working around this, which consists of placing on the object multiple Texture Tags which reference 
the same Maxwell material:  
 
 

 
 

 
In this case, the plugin will write multiple sets of UVs for the object. The UVs for the first Texture Tag will be written to Channel 0, those of the 
second will be written to Channel 1, and so on. In this way, it is possible to export different sets of custom UVs for use with the various textures 
contained in the Maxwell material. 
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  Maxwell for Cinema 4D :: Instance (object) 
 
 

 
 
 
The Instance object allows you to create lightweight duplicates of C4D geometry. Instances are ‘lightweight’ in two ways: 
 
 during modeling, they do not create in-memory duplicates of the geometry they target. Instead, they either draw bounding-boxes for each 

piece of geometry being instanced, or else they are represented by a single constant-size box, circle, or just a point 
 during export and rendering, they are represented in the MXS as Maxwell instances. Each instance takes only a very small amount of memory, 

as compared to the mesh which it duplicates 
 

Reference Object 
 
This link specifies which C4D object will be instanced. This link accepts any C4D object and other Maxwell Instance objects as well. If the linked 
object has other objects under it, they will also be instanced, so it is possible to create lightweight duplicates of complete object-hierarchies using a 
single Maxwell Instance object. 

 
Display 
 
These parameters determine how the instanced geometry will be represented in the C4D viewport. In the interest of performance and to use the 
least memory possible, Instances do not draw full 3D representations of their target objects. Instead, they draw simple bounding-boxes, or 
optionally, a simple circle or point. 
 
If the ‘Auto-size’ parameter is enabled, then the Instance will use the actual size of the geometry it is duplicating to draw bounding-boxes in the 
viewport. Since this applies to all of the referenced object’s children as well, working with ‘Auto-size’ requires some processor time. If you do not 
require this type of representation, you may disable ‘Auto-size’; when this is done, the Instance will not inspect the reference object at all. Instead, 
it will simply draw a point or a box or circle whose size will be determined using the Instance’s Size X/Y/Z parameters. You may also specify another 
object to use for the display; its bounding box will be drawn. 
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  Maxwell for Cinema 4D :: MXS Reference (object) 
 
 

 
 
 
The function of the MXS Reference object is to allow you to link a Maxwell MXS file into your scene at export-time.  
 
Path 
 
This is simply the path to an MXS file. The geometry may be scaled and positioned as usual via the Coord. tab. When an MXS file is loaded, it may 
be opened in Maxwell Studio by clicking the Studio-icon button. 

 
Display 
 
These parameters determine how the reference geometry will be represented in the C4D viewport. Depending on the nature of the geometry, it 
may be desirable to use bounding boxes (one is created for each mesh in the MXS), or points, which are taken from the mesh vertices contained in 
the MXS file. Use the detail parameter to control how many points are drawn: 
 
 

         
Source MXS  Detail: 10% Detail: 100% 

 
Notes 
 
Objects contained in MXS files are always defined in terms of a meter scale. In C4D, however, an arbitrary scale factor may be in effect. For 
example, consider an MXS file which contains a one-meter cube, centered at 0,0,0 in space: it has vertices at +/- 0.5 in each quadrant. If this MXS is 
referenced while C4D's units are set to meters, these coordinates will mean +/- 0.5 meters in C4D, just as they do in the MXS file. If, on the other 
hand, C4D's units are set to millimeters, these coordinates will have a different meaning: the cube will appear to be 1 millimeter in size. In order to 
represent the cube at its natural size, as defined in the MXS file, one would need to scale the MXS Reference 1000x using the scale values in the 
MXS Reference object's Coords tab. 
 
To help with this, the plugin queries the current units setting whenever an MXS Reference object is created, and pre-sets its scale values to make it 
appear at the correct size in the context of the current C4D unit system. If the C4D units are subsequently changed, the MXS reference will 
naturally maintain its current size with respect to the other objects contained in the scene. When the document is exported, depending on the 
Scale Units setting in the exporting Scene Object, the size of all MXS references will be scaled as necessary, in order to obtain a WYSIWYG result. 
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   Maxwell for Cinema 4D :: Camera (tag) 
 
 

 
 
 
The Camera tag contains four groups which are used to control those parts of the Maxwell camera which have no matching parameter in C4D. The 
Camera tag may be attached either to a C4D camera, or to the Scene you are working with. 
 
Exposure 
 
 

 
 

 
These parameters determine the camera's exposure.  
 

EV  
 
EV, or Exposure Value is a number used to express the basic exposure which will be seen in the exported MXS. EV may be used to set the 
exposure directly, where brighter scenes will require a higher EV, or it may be used as an exposure readout when setting fStop, Shutter, and ISO 
manually. For example, an outdoor photo during the daytime may require an EV somewhere around 12-16, while a dark candle-lit scene may 
require a value much lower, maybe around 4-6. Charts containing recommended EV for various lighting conditions can be found online (see the 
end of this manual for a chart from wikipedia.org).  
 
EV is not actually a parameter found on Maxwell cameras – it is a theoretical value which is continuously figured by the plugin itself. The ‘Lock 
exposure to EV’ option is provided for one basic reason: while exposure may be adjusted manually using different combinations of fStop, 
Shutter, and ISO, it is possible to adjust the DOF (depth of field) on the camera using the fStop without also affecting the overall exposure of the 
shot when the plugin is allowed to maintain a given EV. This allows you to adjust the camera’s exposure and DOF on a totally independent basis, 
and this makes setting up exposure much easier and more predictable. 
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fStop  
 
A camera’s fStop refers to the size of its aperture. Lower numbers denote a larger aperture, which exposes the camera’s sensor to more light. 
Additionally, a larger aperture reduces the camera’s DOF (i.e. ‘depth of field’), or the distance between the nearest and furthest points which will 
appear in focus. Smaller apertures (higher fStop numbers) result in a greater DOF, but expose the camera’s sensor to less light. Therefore, as the 
fStop is increased, the exposure must be compensated. This can be done manually, by adjusting the camera’s shutter or ISO values, or it can be 
handled automatically by the plugin by enabling the ‘Lock exposure to EV’ option. When the exposure is locked to the EV, changes to fStop will 
not affect the overall exposure of the output image, since the plugin will adjust the camera’s shutter as necessary to maintain a consistent 
exposure.  
 
ISO  
 
As with a physical camera, the ISO parameter affects the camera sensor’s light-sensitivity. It is not necessary to adjust ISO directly when ‘Lock 
exposure to EV’ is enabled. 
 
Shutter  
 
Specified in units of 1/second, this parameter controls how long the camera’s Shutter is to remain open. As with the ISO parameter, it is not 
necessary to adjust the camera’s Shutter directly when ‘Lock exposure to EV’ is enabled. For convenience, the current FPS value is also shown 
here. 

 
 
Aperture 
 
 

 
 

 
The parameters in this section affect the angle and number of blades used in this camera’s aperture, when the Diaphragm type is set to ‘Polygonal’. 
These properties affect the ‘bokeh’ effect seen in highlights located in out-of-focus portions of the image.  
 
 
Rotary Shutter 
 
 

 
 

 
These parameters express the camera’s theoretical rotary shutter angle given a specified frames-per-second rate. The FPS value is always taken 
from the Frame Rate setting in the current C4D Render Settings.  
 
 
Z-Clip Planes 
 
 

 
 

 
When enabled, Maxwell Render will clip any geometry nearer or further than the Near and Far distances defined here. These distances will also be 
shown in the viewport as red and blue 3D planes when this section is enabled. 
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  Maxwell for Cinema 4D :: Object Properties (tag) 
 
 

 
 
 
The Object Properties tag is a very simple tag which simply contains switches for the various Maxwell ‘Hide from X’ mesh flags: 
 
 Hide: completely hide this object in the render 
 Hide from Camera: hide this object from being seen directly by the camera 
 Hide from Reflections and Refractions: hide this object from reflection/refraction calculations 
 Hide from GI: hide this object from the global-illumination calculation 
 Hide from ZClip: hide this object from Maxwell’s Z-Clip feature 
 Disable Motion Blur: prevents this object from rendering with motion blur 
 Object ID Color determines the color of this object when the Object ID channel is rendered 
 Ignore Normal tag ignores this object’s Normal tag, if it has one 
 Ignore Phong tag ignores this object’s Phong tag, if it has one 

 
Most of these parameters are fairly self-explanatory. The Ignore Phong tag option is provided to make it easier to render an object with no 
smoothing without having to disturb the Cinema Phong tag attached to the object. The Ignore Normal tag option can be useful when rendering 
geometry which was imported from another application; when the tag is used, it is not possible to have Cinema generate its own normals, or to 
render with no smoothing. Note that Normal tags will be ignored automatically if the object is not already triangulated; in that case, the normals 
contained in the tag will not be suitable for rendering the triangulated object and must instead be regenerated from scratch. 
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  Maxwell for Cinema 4D :: Rendering Region (tag) 
 
 

 
 
 
The Rendering Region tag is used to define a visible rectangle to use with Maxwell’s Render Region and Render Blow-up features. As it is 
implemented as a persistent tag, rather than a dynamically-selected ‘rubber-band’ region, the Rendering Region tag offers the ability to 
consistently render the same region multiple times if necessary, or to divide up a large rendering into smaller portions without needing to know the 
actual pixel dimensions involved. 
 
Options 
 
 

 
 

 
The parameters in this section are used to enable or disable this Rendering Region (it will be ignored when disabled), to change the color which is 
used to paint it on the screen, and whether it will be used to perform Maxwell’s Render Region or Render Blow-up function. Render Region simply 
excludes all pixels outside of the specified rectangle from the rendering (i.e. they will just be rendered black), resulting in a faster render of the 
desired pixels. Render Blow-up uses the specified rectangle to zoom in on the viewport, and renders the selected rectangle at the full height or 
width of the output resolution. 
 
Rectangle 
 
 

 
 

 
The Left and Top parameters define how far from the left and top edges of the rendered area the rendering rectangle begins. The Width and Height 
parameters define the size of the rectangle, as a percentage of the rendered area’s height/width. 
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Maxwell Fire 
 

 
 
Maxwell Fire provides an interactive rendering experience from within the plugin. 
 
 
How it works 
 
 
To activate Fire, it is first necessary to have a Scene Object; at any given time, only one Scene Object can be the object being rendered in Maxwell 
Fire. To activate Maxwell Fire, show the Scene Object in the Attributes Manager and click the grey 'Fire' button: 
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Once the Scene has been linked to Maxwell Fire, the Fire button will change color, and another button will appear to its right: 
 
 

 
 
 
The new button is used to re-send the scene to Fire; this is necessary when objects have moved, or when material assignments have been changed; 
these actions are not interactive. Notice as well that (in version R11.5 and higher) the Object Manager icon for the Scene Object also changes to the 
yellow Fire icon, making it easy to tell which Scene is currently rendering in Fire. To unlink the Scene from Fire, simply click the yellow Fire button 
again, or link another Scene. 
 
Additionally, a new Fire Options group will appear in Scene Object > Engine tab: 
 
 

 
 
 
This group is only visible when the Scene is linked to Fire. Sampling Level and Threads directly control their parameters in the Fire render engine, 
while the Quality parameter determines the actual size of the image being rendered (the image is interpolated to fit the current size of the Fire 
window). 
 
When the Scene is linked to Fire, the Fire window will be opened, if necessary. There are also a very few controls in the Maxwell Fire window itself: 
 
 

 
 
 
The first button enables or disables Fire rendering without unlinking the associated Scene. The second is a duplicate of the re-send button in the 
Scene Object's Attributes Manager interface; it causes the scene to be freshly exported to Fire. The third button allows you to save the current Fire 
image to disk. At the right-hand side, there is a toggle which switches between 'Render' and 'Active' camera modes; in Render mode, only the 
current rendering camera will be shown in Fire, while in Active mode, which ever viewport is active will be rendered. By default this is toggled to 
Render mode, to allow for adjusting the camera in viewports other than the one being rendered. 
 
At the bottom of the Fire window is a progress bar, and buttons for warnings and errors from the engine; if the scene contains errors, click the 
buttons to find out what is preventing the render from proceeding. 
 
 

 
 
 
When Fire is active, changes to materials, Scene parameters, and cameras are fully interactive and require no special actions to update. As 
mentioned previously, changes which affect the scene physically, such as the addition, removal, or movement of objects, or the assignment of 
materials to objects, will require that the Scene be re-exported.  
 
Maxwell Fire is also used in the plugin's Material Editor, and allows changes to materials to be visualized interactively. You may set the number of 
threads allocated to the material preview renderer in the plugin's Preferences page. 
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Maxwell Preferences 
 

 
 
 
The plugin adds a Maxwell page to C4D’s Preferences. The parameters in this page are used to control various aspects of how the plugin works. 
 
 
Material Preferences  

The Sampling Level, Preview Scene, and Viewport textures parameters are used when new Materials are created. Texture projection is used to set 
the projection for the texture tags associated when plugin Materials are assigned to objects. The Preview threads value determines how many 
threads to use when rendering previews for plugin Materials. Enable MXM Linking when MXM files are imported simply controls whether MXM 
Linking will be activated for materials when they are imported from MXM files.  
 
Note: in versions prior to C4D R12, the Enable/Disable Real-time Material Preview option is also contained here, rather than as a button in the 
material editor, as described in Enable/Disable Real-time Preview on page 38. 
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Paths  

These paths, in addition to the normal C4D Texture Paths, will be searched when attempting to locate missing textures and MXM files. Whereas the 
C4D Texture Paths are not searched recursively, these paths each provide a Depth value, which is used to determine how many directories deep to 
search under the specified location. 
 
In addition to the paths listed here and those set in C4D’s Texture Paths, the plugin also recursively searches the following locations: 
 
 /Maxwell 2.0/materials database/mxm files  
 /Maxwell 2.0/materials database/textures  
 /Maxwell 2.0/hdri  
 
Checking the Don’t search standard Maxwell directories option will cause the plugin not to add these paths to the search list. Note that changes 
made to the search paths require a restart of C4D before they may take effect – in general, adding paths will have an affect during the session, but 
removing them will not. 
 
Defaults and Actions  
 
If you have entered an Output Name here, it will be used for exporting when no name has been set in the Scene being exported. If no Output Name 
is set here, and there is also no name in the Scene, then the document name will be used. Similarly, if you have entered an Output Folder here, it 
will be used when none is specified in the Scene, while if there is none set, the plugin will try to use the path of the current document, or the 
current directory if the document has not been saved yet. 
 
You can specify the plugin’s document-overwriting policy using the last item. The choices are to use a warning dialog, to always overwrite existing 
files, or to automatically rename the output. When using automatic renaming, an incremental number will be appended to the filename if the 
specified file already exists. 
 
File browser startup directories  
 
The paths entered here will be used to set the startup directory for file-browser dialogs which are started from the plugin’s Material Editor user-
interface. When the option is enabled, the directories specified will be used for the first browsing for each file type; subsequent browsing will 
continue from the last-browsed directory for the file type. Note that this feature is not effective for files browsed from Attributes Manager 
parameters, and also that it may not work at all on C4D versions earlier than R10.5. If you do not wish the plugin to attempt to perform this action, 
enable the Allow Cinema to decide option. 
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Maxwell MXS Import Preferences 
 

 
 
 
The plugin adds an MXS Import page to C4D’s Import/Export Preferences. 
 
 
Options  

Maxwell MXS files contain mesh geometry in a meter-sized scale; depending on the scale you have set in C4D's Units Preferences, you may need to 
scale your MXS imports by some factor, and this is done using the Scale Factor parameter; all geometry will be scaled by this amount (i.e. scaled up 
1000x in the screenshot above) when it is imported.  
 
Maxwell MXS files use the concept of a currently-selected camera; when an MXS is imported, it is this camera which will be used to define C4D's 
Render Settings. Using the Selected Camera parameter, it is possible to override the camera selected in the MXS and use another one. 
 
 
Filtering  

Using the parameters in this group, it is possible to define what should and what should not be imported from MXS files. 
 

 Create Scene Object: read the settings contained in the MXS and use them to create a Scene Object 
 Import cameras: determines whether or not to import cameras from the MXS 
 Import materials: determines whether or not to import materials from the MXS 
 Import Meshes: determines whether or not to import meshes from the MXS 
 Meshes to include (CSV): a list of names specifying which meshes may be included in the import 
 Meshes to exclude (CSV): a list of names specifying which meshes must be excluded from the import 

 
The first four are fairly self-explanatory. The last two use string-matching on the provided list to accomplish their function. So, given the value for 
Meshes to include shown above, only meshes whose names begin with cube and sphere will be imported. That is to say, objects with names such as 
cube1, cube.1, cubeAnything, sphereLight, etc. 
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Other  

The Import Commands (CSV) parameter is a variable-length list of strings, separated by commas, which represent other commands that the plugin 
will use to tailor the created C4D document during MXS import. Currently, only three import commands are supported: 
 

 norender: specifies that Render Settings > Regular Image will be disabled in the document 
 motionvector: specifies that Motion Vector should be enabled in Multi-Pass 
 objectid: specifies that Object ID should be enabled in Multi-Pass 

 
Other commands may be added in the future. 
 
 
Notes  

The parameters presented above are also available when opening an MXS file with C4D via the command-line. Their names in this case are only 
slightly different, but their functions are the same: 
 

 -scale correlates to the Scale Factor parameter; specified as such: -scale:1000 
 -camera correlates to the Selected Camera parameter; specified as such: -camera:mainCamera 
 -nodata equivalent to un-checking the Create Scene Object option 
 -nocameras equivalent to un-checking the Import cameras option 
 -nomaterials equivalent to un-checking the Import materials option 
 -nomeshes equivalent to un-checking the Import meshes option 
 -include correlates to the Meshes to include (CSV) parameter, specified as such: -include:cube,sphere 
 -exclude correlates to the Meshes to exclude (CSV) parameter, specified as such: -exclude:cube,sphere 
 -commands correlates to the Import Commands (CSV), specified as such: -commands:norender,motionvector 

 
Using these command-line versions of the MXS import options, it is possible to batch-convert a series of MXS files into C4D files. It is not possible to 
batch-render them in C4D (i.e. by using the -render C4D command-line option) though, because C4D does not pass the command-line to the plugin 
until after it has opened and rendered the specified file; in that case, the values specified in Preferences > Import/Export > Maxwell MXS Import will 
be used instead, as they are the only ones available to the plugin at the time of import.  
 
Also note that currently, normals are not imported from the MXS file; they are calculated by C4D after the geometry has been imported. Also not 
currently supported for import are instances, and material selections. 
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  Maxwell for Cinema 4D :: Convert Cinema Materials (command) 

 

 
 
 
This command is provided for the purpose of translating native C4D materials into Maxwell Materials. Several options for controlling exactly how 
this is done are provided. 
 
 
How should the conversion be performed? 
 
Firstly, there are three mutually-exclusive options; all will create new Maxwell Materials and add them to the C4D Material Manager. Optionally, 
the choice may be made to also create duplicates of existing Texture tags with the newly-created Maxwell Materials assigned to them. 
Alternatively, instead of duplicating existing Texture tags, the plugin can also directly replace the material assignments of the existing tags with the 
newly-created Maxwell Materials. 
 
The choice is also given whether the plugin ought to perform conversion of all existing C4D materials, or just the ones which are currently-selected 
in the C4D Material Manager. Optionally, the plugin will render previews for all converted materials automatically, on a background thread. 
 
Render Cinema procedural textures to disk? 
 
This section works in a way identical to that of the corresponding section of the Scene object.  
 
Notes on automatic C4D material conversion 
 
It is not possible to make a direct mapping between how C4D and Maxwell materials work; the models used are just completely different. That said 
the plugin does go to a fairly great length in its attempt to translate native C4D materials into useful Maxwell representations. Here is how the C4D 
channels and parameters are translated: 
 

Color: Color and Brightness will be used to determine the resulting Maxwell material’s basic color, which is controlled using the 
Reflectance 0 color of its base BSDF. If a texture is specified in the C4D material, it will be placed in the base BSDF’s Reflectance 
0 map channel. If the texture is procedural then it will be mixed with the C4D material’s Color and Brightness parameters using 
the specified Mix Mode and Mix Strength. 

 
Diffusion: Brightness will be used to influence the basic color of the generated Maxwell material. If a texture is specified, it will be used in 

the most reflective layer of the generated Maxwell material. If the texture is procedural, it will also be used to generate a new 
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map for the base BSDF’s Reflectance 0 channel; basically, this could be though of as a dynamically-generated ‘dirt’ map which 
combines the basic Reflectance 0 color of the BSDF with the procedural diffusion map. As with a procedural Color map, the 
appearance of this map will be influenced by the Mix Mode and Mix Strength parameters. 

 
Luminance: When activated, the plugin will create a Maxwell Emitter material. In this case, any other C4D channels will be ignored. If an 

HDR (i.e. mxi, hdr, exr) texture is specified, then this will be used to create the Maxwell material as an image-based emitter; 
otherwise, the output color will be determined using the C4D Color parameter, while the output power will be determined 
using the C4D Brightness parameter. Output power for auto-generated emitters is always specified in lux (lumens per m2) to 
ensure that output power scales reasonably with different scene sizes.  

 
Note: if the luminance color is effectively pure black, and there is also no file-based or procedural texture in the channel, this 
channel will be treated as if it were disabled. 

 
Specular: The plugin will create a plasticine or metallic Material, depending on the Mode parameter. When set to metallic, a single BSDF 

will be created and its Reflectance 90 channel will be set to a weaker version of the C4D material’s basic color. Otherwise, a 2-
layer plasticine material will be created. In either case, the C4D Width parameter will be used to control the material’s 
roughness, in order to give a reflective response similar to that of the C4D material. 

 
Transparency: When activated, the plugin will create a dielectric Maxwell material. In this case, the Color and Specular channels in the C4D 

material will be ignored, if they are activated, and instead the Color and Brightness parameters in the Transparency channel will 
be used to determine the base BSDF’s Transmittance color. If a texture is specified, then it will be placed in the BSDF’s 
Transmittance map. It is important to use a realistic Refraction value, as this will be directly translated by the plugin, and will be 
placed in the BSDF’s Nd field. The attenuation of the BSDF will be set using the Cinema Absorption distance, factoring for the 
current scene scale. The Blurriness parameter will be used to increase the material’s attenuation, and also to add some 
roughness, again in an attempt to approximate what would be seen in the C4D material being converted.  

 
Note: if the transparency color is effectively pure black, and there is also no file-based or procedural texture in the channel, this 
channel will be treated as if it were disabled. Also, if there a map is specified, and that map contains only greyscale values, the 
Transparency channel will be used as an alpha channel instead. 

 
Bump: the texture specified here will be placed in the Maxwell Material’s Global Bump channel, with the Strength parameter being 

translated into the Global Bump value 
 
Normal: This works similarly to the Bump channel, except that the map will have normal mapping enabled, and the values specified for 

Flip X and Flip Y will be transferred into their corresponding places in the Maxwell bump channel. 
 
Alpha: A texture found here will be placed in the Mask map of each layer in the material, producing a clip-mapped Maxwell Material. If 

the texture specified resides in a C4D library, and uses alpha-channel to accomplish clipping, then this map will be translated by 
the plugin and saved to disk as a black-and-white Maxwell-style clip map. 

 
Displacement: The texture specified here will be placed in the Maxwell Material’s Displacement layer, with the Strength and Height 

parameters being used to set the Maxwell displacement Height. 
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Maxwell for Cinema 4D :: Notes on Rendering Hair  

 
This section discusses how the plugin translates C4D Hair into Maxwell Hair, which is a new rendering primitive introduced in Maxwell Render 
version 2.6.  
 
Firstly, the most important factor to keep in mind is that it is only possible to transfer the hair guides from C4D Hair into the MXS file as Maxwell 
Hair. In cases where this does not suffice, it is advised that you use the Hair object's Generate tab to output geometry (be sure to check the 'Single 
Object' option). The plugin detects whether this (i.e. generating 'Single Object' hair geometry) is the case; there is no need to add any special tags 
to control it. 
 
The diameter of the generated hair primitives is controlled using the Root and Tip values found in the C4D Hair Material. If no other material is 
attached to the Hair Object, a material will be automatically generated using the Hair Material's Color gradient. Here is an example of such a 
material: 
 
 

 
 
 
If possible, root UV coordinates will be exported, as shown in the following images: 
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Maxwell for Cinema 4D :: Non-GUI Rendering 
 
In addition to the standard GUI-based methods provided by the plugin, it is also possible to ask the plugin to render a Scene via C.O.F.F.E.E (or 
C++/Python/etc.) code. Here is an example of how to do that (in C.O.F.F.E.E): 
 
 

// Maxwell plugin command IDs 
 
var renderToMxs      = 1024908; 
var renderToStudio   = 1024907; 
var renderToNetwork  = 1027368; 
var renderActiveView = 1024906; 
var renderRenderView = 1024905; 
 
// we can render the first scene found: 
SpecialEventAdd(renderRenderView); 
 
// ...or we can get the active Cinema doc 
var doc = GetActiveDocument(); 
 
if (doc) 
{ 
    // find the desired Maxwell Scene Object 
    var scene = doc->FindObject("my.scene"); 
 
    if (scene) 
    { 
        // ...and tell it to render: 
        scene->Message(renderRenderView); 
    } 
} 

 
 
It is also possible to render in Maxwell when starting Cinema from the command-line. In this case, it is always the first Maxwell Scene Object found 
in the Cinema document which will be rendered; if none is found, an error will be reported. All that is necessary is to add the -rendermxs flag to the 
command-line: 
 
 

> "[path to cinema 4d.exe]" "c:\doc.c4d" -nogui -rendermxs 
 
 
When this command-line is executed, C4D will be started in 'nogui' mode, and the first Maxwell Scene Object found in doc.c4d will be rendered in 
Maxwell Render. The parameters contained in the Scene Object will be used; for example, if the Scene Object has Animation enabled, an animation 
will be exported and rendered. Additionally, it is possible to override various parameters specified in the Scene Object. This is done by putting them 
directly on the Cinema command-line. When doing so, parameter values should never be quoted, and spaces should be encoded using +20. Several 
plugin-specific commands are available: 
 

 
 -outputdir  Overrides Scene Object > Output > Folder. Usage: -outputdir:c:\dir+20name+20with+20spaces. 
 -outputname Overrides Scene Object > Output > Name. Usage: -outputname:output+20name+20with+20spaces. 
 -outputformat Overrides Scene Object > Output > Name > Extension/Depth. Usage: -outputformat:tif32. 
 -frames  Enables animation, using the specified frame range (separated by a dash). Usage: -frames:2-24. 
 -framestep  If animation is enabled, this parameter overrides the animation frame step value. Usage: -framestep:3. 
 -cmdline  Modifies the Scene Object command-line. Usage: -cmdline:append (the default) or -cmdline:override. 

 
 
Regarding the -cmdline option, the values appended to (or used to override) the Scene Object command-line parameters (i.e. Scene Object > Engine 
> Command Line), are communicated by placing them directly on the C4D command-line. Note that since C4D also uses the -nogui command, you 
must use Maxwell Render's -n alias for this parameter instead. Here is an example command-line, which renders a series of frames from a given 
C4D file: 
 
 

> "[path to cinema 4d.exe]" "c:\doc.c4d" -nogui -rendermxs -outputdir:c:\new+20output+20dir  
 -outputname:new+20output+20name -outputformat:png16 -frames:1-21 -framestep:2 -cmdline:override  
 -channel:alpha,on,32,tif -channel:material,on,16,png -th:4 -sl:5.65 -nomxi -n -nowait 
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Exposure values (ISO 100 speed) for various lighting conditions 
 

Lighting Condition EV100 
Daylight 
Light sand or snow in full or slightly hazy sunlight (distinct shadows) 16 
Typical scene in full or slightly hazy sunlight (distinct shadows) 15 
Typical scene in hazy sunlight (soft shadows) 14 
Typical scene, cloudy bright (no shadows) 13 
Typical scene, heavy overcast 12 
Areas in open shade, clear sunlight 12 
Outdoor, Natural light 
Rainbows 
Clear sky background 15 
Cloudy sky background 14 
Sunsets and skylines 
Just before sunset 12–14 
At sunset 12 
Just after sunset 9–11 
e Moon, altitude > 40° 
Full 15 
Gibbous 14 
Quarter 13 
Crescent 12 
Moonlight, Moon altitude > 40° 
Full −3 to −2 
Gibbous −4 
Quarter −6 
Aurora borealis and australis 
Bright −4 to −3 
Medium −6 to −5 
Outdoor, Artificial Light 
Neon and other bright signs 9–10 
Night sports 9 
Fires and burning buildings 9 
Bright street scenes 8 
Night street scenes and window displays 7–8 
Night vehicle traffic 5 
Fairs and amusement parks 7 
Christmas tree lights 4–5 
Floodlit buildings, monuments, and fountains 3–5 
Distant views of lighted buildings 2 
Indoor, Artificial Light 
Galleries 8–11 
Sports events, stage shows, and the like 8–9 
Circuses, floodlit 8 
Ice shows, floodlit 9 
Offices and work areas 7–8 
Home interiors 5–7 
Christmas tree lights 4–5 

 
(table from wikipedia.org @ http://en.wikipedia.org/wiki/Exposure_value) 


